

    
      
          
            
  
SunFounder ESP32 スターターキット

SunFounder ESP32 スターターキットをお選びいただき、ありがとうございます。


注釈

このドキュメントは以下の言語で利用可能です。



	Lecciones en línea de español


	Deutsch Online-Kurs


	日本語オンライン教材


	English Online-tutorials







ご希望の言語でドキュメントにアクセスするために、それぞれのリンクをクリックしてください。



[image: _images/esp32_ultimate_kit.png]
ESP32ラーニングキットへようこそ！この包括的なキットは、ESP32マイクロコントローラの多機能な世界を初心者から熟練開発者まで深く探ることを目的として設計されています。中心にはESP32 WROOM 32Eがあり、LED、センサー、モーターなどの付属部品が豊富に揃っているので、さまざまなプロジェクトを探索できます。

基本的な電子工作からIoTの統合まで、このキットには全てが備わっています。MicroPythonの愛好者のために、MicroPythonの構造化された導入から、IDEのセットアップや基本的な文法のレッスンまで提供しています。Arduinoユーザーも忘れられておらず、Arduinoを始めるための専用セクションや基本プロジェクトのスイートが含まれていて、学習プロセスをスタートできます。

クリエイティブな方には、Scratchとの統合に関する楽しいセクションがあり、プログラミングとストーリーテリングの融合を実現します。キット内の各プロジェクトは綿密に概説されており、目的、回路の組み立て、プログラミングの側面を理解することを確実にします。

多数のゲームプロジェクト、実用的なアプリケーション、トラブルシューティングのFAQを備えたこのキットは、全てのユーザーに豊かな学習経験を約束します。ESP32の冒険を始めてみましょう！

ご質問や他の興味深いアイディアがあれば、service@sunfounder.comまでメールをお送りください。

表示言語について

英語に加えて、このコースの他の言語に取り組んでいます。協力に興味がある方はservice@sunfounder.comまでご連絡ください。ご協力いただいた方には無料で製品を提供いたします。
それまでは、Google Translateを使用して英語をお求めの言語に変換することをおすすめします。

手順は以下の通りです。


	このコースのページで、右クリックして Translate to xx を選択します。現在の言語が望むものでない場合は、後で変更できます。




[image: _images/translate1.png]

	右上隅に言語のポップアップが表示されます。メニューボタンをクリックして choose another language します。




[image: _images/translate2.png]

	反転した三角形のボックスから言語を選択し、 Done をクリックします。
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著作権に関する通知

このマニュアルに含まれるテキスト、画像、コードなど全ての内容はSunFounder社が所有しています。関連する規定や著作権法のもとで、著者や関連する権利保持者の合法的権利を侵害することなく、個人的な学習、調査、楽しみ、またはその他の非営利目的のためにのみ使用する必要があります。許可なく商業的利益のためにこれらを使用する個人や組織に対して、会社は法的措置を取る権利を留保します。





            

          

      

      

    

  

    
      
          
            
  
コードをダウンロードする

こちらはESP32スターターキットの完全なコードパッケージです。以下のリンクからダウンロードできます：

SunFounder ESP32スターターキット [https://github.com/sunfounder/esp32-starter-kit/archive/refs/heads/main.zip]

ダウンロードが完了したら、ファイルを解凍し、対応するソフトウェアで関連する例示コードやプロジェクトファイルを開いてください。これにより、キットが提供するすべてのコードとリソースを閲覧し、利用することができます。




            

          

      

      

    

  

    
      
          
            
  
Arduinoユーザーの皆様へ

こちらはESP32スターターキットの完全なコードパッケージです。以下のリンクからダウンロードできます：


	SunFounder ESP32スターターキット [https://github.com/sunfounder/esp32-starter-kit/archive/refs/heads/main.zip]




ダウンロードが完了したら、ファイルを解凍し、対応するソフトウェアで関連する例示コードやプロジェクトファイルを開いてください。これにより、キットが提供するすべてのコードとリソースを閲覧し、利用することができます。
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	8.10 アンドロイドアプリケーション - ArduinoとBluetoothを介したRGB LED操作








            

          

      

      

    

  

    
      
          
            
  
1.1 Arduino IDEのインストール（重要）

Arduino IDE（Arduino統合開発環境）は、Arduinoプロジェクトを完遂するために必要なすべてのソフトウェアサポートを提供します。これはArduinoチームによって提供されているArduino専用のプログラミングソフトウェアで、プログラムの記述とArduinoボードへのアップロードを可能にします。

Arduino IDE 2.0はオープンソースプロジェクトです。その頑丈な前身であるArduino IDE 1.xから大きく進化し、刷新されたUI、改善されたボード・ライブラリマネージャー、デバッガー、オートコンプリート機能などが追加されています。

このチュートリアルでは、Windows、Mac、またはLinuxコンピュータにArduino IDE 2.0をダウンロードしてインストールする方法をご紹介します。


必要条件


	Windows - Win 10以降、64ビット


	Linux - 64ビット


	Mac OS X - バージョン10.14:「Mojave」以降、64ビット






Arduino IDE 2.0のダウンロード


	Arduino IDE 2.0.0 Page にアクセスします。


	ご使用のOSバージョンに合ったIDEをダウンロードします。


[image: ../../_images/sp_001.png]









インストール


Windows


	ダウンロードした arduino-ide_xxxx.exe ファイルをダブルクリックして実行します。


	ライセンス契約を読み、同意します。


[image: ../../_images/sp_002.png]





	インストールオプションを選択します。


[image: ../../_images/sp_003.png]





	インストール場所を選択します。システムドライブ以外のドライブにソフトウェアをインストールすることを推奨します。


[image: ../../_images/sp_004.png]





	そして完了します。


[image: ../../_images/sp_005.png]









macOS

ダウンロードした arduino_ide_xxxx.dmg ファイルをダブルクリックし、指示に従って Arduino IDE.app を Applications フォルダにコピーします。数秒後にArduino IDEが正常にインストールされたことが確認できます。

[image: ../../_images/macos_install_ide.png]


Linux

LinuxシステムへのArduino IDE 2.0のインストールチュートリアルは、以下を参照してください： https://docs.arduino.cc/software/ide-v2/tutorials/getting-started/ide-v2-downloading-and-installing#linux




IDEの起動


	Arduino IDE 2.0を初めて開くと、自動的にArduino AVRボード、内蔵ライブラリ、その他必要なファイルがインストールされます。


[image: ../../_images/sp_901.png]





	また、ファイアウォールやセキュリティセンターがデバイスドライバのインストールを求めるポップアップを何回か表示する場合があります。すべてインストールしてください。


[image: ../../_images/sp_104.png]





	これでArduino IDEは使用準備が整いました！



注釈

ネットワークの問題やその他の理由で一部のインストールがうまくいかなかった場合、Arduino IDEを再度開くと残りのインストールが完了します。すべてのインストールが完了した後、出力ウィンドウは「Verify」または「Upload」をクリックしない限り自動的には開きません。














            

          

      

      

    

  

    
      
          
            
  
1.2 Arduino IDEの紹介

[image: ../../_images/sp_ide_2.png]

	検証(Verify): コードをコンパイルします。構文の問題がある場合は、エラーとして提示されます。


	アップロード(Upload): コードをボードにアップロードします。このボタンをクリックすると、ボード上のRXとTXのLEDが高速で点滅し、アップロードが完了するまで止まりません。


	デバッグ(Debug): 一行ごとのエラーチェックのために。


	ボードの選択(Select Board): ボードとポートのクイック設定。


	シリアルプロッター(Serial Plotter): 読取値の変化をチェックします。


	シリアルモニター(Serial Monitor): ボタンをクリックするとウィンドウが開きます。コントロールボードから送信されたデータを受信します。デバッグにとても便利です。


	ファイル(File): メニューをクリックすると、ファイルの新規作成、開く、保存、閉じる、パラメータの設定などを含むドロップダウンリストが表示されます。


	編集(Edit): メニューをクリックします。ドロップダウンリストには、 切り取り(Cut)、 コピー(Copy)、 貼り付け(Paste)、 検索(Find) などの編集操作とそれに対応するショートカットがあります。


	スケッチ(Sketch): 検証(Verify)、 アップロード(Upload)、ファイルの 追加(Add) などの操作を含みます。より重要な機能は ライブラリをインクルード(Include Library) で、ここでライブラリを追加できます。


	ツール(Tool): いくつかのツールを含み、最も頻繁に使用されるのはボード（使用するボード）とポート（ボードが接続されるポート）です。コードをアップロードするたびに、これらを選択または確認する必要があります。


	ヘルプ(Help): 初心者の場合は、メニューの下にあるオプションを確認し、IDEの操作、紹介情報、トラブルシューティング、コード説明など、必要なヘルプを得ることができます。


	出力バー(Output Bar): ここで出力タブを切り替えます。


	出力ウィンドウ(Output Window): 情報を印刷します。


	ボードとポート(Board and Port): ここでコードアップロードに選択されたボードとポートをプレビューできます。間違っている場合は、 ツール(Tools) -> ボード(Board) / ポート(Port) で再選択できます。


	IDEの編集エリア。ここでコードを記述できます。


	スケッチブック(Sketchbook): スケッチファイルを管理するために。


	ボードマネージャ(Board Manager): ボードドライバーを管理するために。


	ライブラリマネージャ(Library Manager): ライブラリファイルを管理するために。


	デバッグ(Debug): コードのデバッグを助けます。


	検索(Search): スケッチからコードを検索します。







            

          

      

      

    

  

    
      
          
            
  
1.3 ESP32ボードのインストール（重要）

ESP32マイクロコントローラをプログラムするためには、Arduino IDEにESP32ボードパッケージをインストールする必要があります。以下のステップバイステップガイドに従ってください：

ESP32ボードのインストール


	Arduino IDEを開きます。 File を選択し、ドロップダウンメニューから Preferences を選びます。


[image: ../../_images/install_esp321.png]





	環境設定ウィンドウで、 Additional Board Manager URLs フィールドを探します。クリックしてテキストボックスをアクティブにします。


[image: ../../_images/install_esp322.png]





	次のURLを Additional Board Manager URLs フィールドに追加します： https://espressif.github.io/arduino-esp32/package_esp32_index.json。このURLはESP32ボードのパッケージインデックスファイルを指します。 OK ボタンをクリックして変更を保存します。


[image: ../../_images/install_esp323.png]





	Boards Manager ウィンドウで、検索バーに ESP32 と入力します。 Install ボタンをクリックしてインストールプロセスを開始します。これにより、ESP32ボードパッケージがダウンロードおよびインストールされます。


[image: ../../_images/install_esp324.png]





	おめでとうございます！Arduino IDEにESP32ボードパッケージを正常にインストールしました。




コードをアップロードする


	まず、Micro USBケーブルを使用して、ESP32 WROOM 32Eをコンピューターに接続します。


[image: ../../_images/plugin_esp32.png]





	次に、ツール -> ボード -> esp32 をクリックして、正しいボード、ESP32 Dev Moduleを選択します。


[image: ../../_images/install_esp325.png]





	ESP32がコンピュータに接続されている場合は、 Tools -> Port に進んで正しいポートを選択できます。


[image: ../../_images/install_esp326.png]





	さらに、Arduino 2.0では、ボードとポートを迅速に選択する新しい方法が導入されました。ESP32の場合、通常は自動的に認識されないため、 Select other board and port をクリックする必要があります。


[image: ../../_images/install_esp327.png]





	検索ボックスに ESP32 Dev Module と入力し、表示されたら選択します。次に、正しいポートを選択し OK をクリックします。


[image: ../../_images/install_esp328.png]





	その後、このクイックアクセスウィンドウを通じて選択できます。ただし、後続の使用時には、ESP32がクイックアクセスウィンドウで利用できない場合があり、上記の2ステップを繰り返す必要があることに注意してください。


[image: ../../_images/install_esp329.png]





	これらの方法のどちらも、正しいボードとポートを選択するために利用できますので、最も適した方法を選んでください。これで、ESP32にコードをアップロードする準備が整いました。







            

          

      

      

    

  

    
      
          
            
  
1.4 ライブラリのインストール（重要）

ライブラリとは、Arduino IDEの機能を拡張するための事前に書かれたコードや関数の集まりです。ライブラリを利用することで、様々な機能の用意されたコードを使用でき、複雑な機能のコーディングにかかる時間や労力を節約できます。

ライブラリをインストールする主な方法は2つあります：


ライブラリマネージャーからのインストール

多くのライブラリはArduinoライブラリマネージャーを通じて直接利用可能です。ライブラリマネージャーにアクセスするには、次の手順に従ってください：


	Library Manager で、希望のライブラリを名前で検索するか、異なるカテゴリーを閲覧します。


注釈

ライブラリのインストールが必要なプロジェクトでは、どのライブラリをインストールするかを示すプロンプトが表示されます。"ここではDHTセンサーライブラリが使用されていますので、ライブラリマネージャーからインストールしてください"といった指示に従ってください。プロンプトに従って推奨されるライブラリをインストールしてください。



[image: ../../_images/install_lib3.png]


	インストールしたいライブラリを見つけたら、それをクリックし、次に Install ボタンをクリックします。

[image: ../../_images/install_lib2.png]


	Arduino IDEは自動的にライブラリをダウンロードしてインストールします。






手動でのインストール

Library Manager を通じて利用できないライブラリもあり、それらは手動でインストールする必要があります。これらのライブラリをインストールするには、次の手順に従ってください：


	Arduino IDEを開き、 Sketch -> Include Library -> Add .ZIP Library に進みます。

[image: ../../_images/a2dp_add_zip.png]


	ライブラリファイルが置かれているディレクトリ（例えば esp32-starter-kit\c\libraries フォルダ）に移動し、希望のライブラリファイル（例えば ESP32-A2DP.zip）を選択してから、 Open をクリックします。

[image: ../../_images/a2dp_choose.png]


	しばらくすると、インストールが成功したことを示す通知が表示されます。

[image: ../../_images/a2dp_success.png]


	ESP8266Audio.zip ライブラリを追加するには、同じプロセスを繰り返します。





注釈

上記のいずれかの方法でインストールしたライブラリは、Arduino IDEのデフォルトのライブラリディレクトリにあります。通常は C:\Users\xxx\Documents\Arduino\libraries に位置しています。

ライブラリディレクトリが異なる場合は、 File -> Preferences に進むことで確認できます。


[image: ../../_images/install_lib1.png]









            

          

      

      

    

  

    
      
          
            
  
2.1 LEDを点灯させよう

プログラム学習の最初の一歩として"Hello, world!"を出力するように、LEDをプログラムで制御することは物理プログラミングを学ぶための伝統的な入門です。

必要な部品

このプロジェクトには、以下のコンポーネントが必要です。

全キットを購入することは非常に便利です。以下のリンクから購入できます：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






また、以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	LED

	BUY






利用可能なピン

このプロジェクトで使用可能なESP32ボード上のピンのリストです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_2.1_led.png]
この回路は簡単な原理で動作し、図に示されているように電流の方向があります。ピン26が高レベルを出力すると220オームの電流制限抵抗を通過してLEDが点灯します。ピン26が低レベルを出力するとLEDが消えます。

配線図

[image: ../../_images/2.1_hello_led_bb.png]
コードをアップロードする


	ファイル 2.1_hello_led.ino をパス esp32-starter-kit-mainccodes2.1_hello_led から開くか、このコードをArduino IDEに直接コピーします。



  
    
    

    2.2 フェーディング
    

    

    
 
  

    
      
          
            
  
2.2 フェーディング

前回のプロジェクトでは、デジタル出力を使用してLEDをオン/オフすることで制御しました。今回のプロジェクトでは、パルス幅変調（PWM）を活用してLEDに呼吸効果を作り出します。PWMは、正方形波信号のデューティ比を変えることで、LEDの明るさやモーターの速度を制御する技術です。

PWMでは、LEDを単純にオン/オフする代わりに、各サイクル内でLEDがオンになる時間とオフになる時間の割合を調整します。LEDを迅速にオン/オフする間隔を変えながら切り替えることで、LEDが徐々に明るくなったり暗くなったりする錯覚を生み出し、呼吸効果を模倣します。

ESP32 WROOM 32EのPWM機能を使用することで、LEDの明るさをスムーズかつ正確に制御できます。この呼吸効果は、プロジェクトにダイナミックで視覚的に魅力的な要素を加え、目を引くディスプレイや雰囲気を作り出します。

必要な部品

このプロジェクトには、以下の部品が必要です。

一式を購入することは非常に便利です。こちらがリンクです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	LED

	BUY






利用可能なピン

こちらは、このプロジェクトのためのESP32ボード上で利用可能なピンのリストです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_2.1_led.png]
このプロジェクトは最初のプロジェクト 2.1 LEDを点灯させよう と同じ回路ですが、シグナルタイプが異なります。最初のプロジェクトはピン26からデジタルの高/低レベル（0&1）を直接出力してLEDを点灯/消灯させるもので、このプロジェクトはピン26からPWM信号を出力してLEDの明るさを制御します。

配線図

[image: ../../_images/2.1_hello_led_bb.png]
コード


注釈


	ファイル 2.2_fading_led.ino をパス esp32-starter-kit-main\c\codes\2.2_fading_led 以下から開けます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 Upload ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    2.3 カラフルライト
    

    

    
 
  

    
      
          
            
  
2.3 カラフルライト

このプロジェクトでは、RGB LEDを使用した加法色混合の魅力的な世界について探求します。

RGB LEDは、赤、緑、青の三原色を一つのパッケージに組み合わせています。これら三つのLEDは共通のカソードピンを共有し、各アノードピンが対応する色の強度を制御します。

各アノードに加える電気信号の強度を変えることで、幅広い色を作り出すことができます。たとえば、高強度の赤と緑の光を混ぜると黄色の光が、青と緑の光を混ぜるとシアンが生成されます。

このプロジェクトを通じて、加法色混合の原理を学び、RGB LEDを操作して魅力的で活発な色を表示させることで、私たちの創造力を解き放ちます。

必要な部品

このプロジェクトには以下のコンポーネントが必要です。

キット全体を購入することは非常に便利です。リンクはこちらです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






下記のリンクから個別に購入することもできます。







	コンポーネント紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	RGB LED

	BUY






利用可能なピン

こちらは、このプロジェクトのためにESP32ボード上で利用可能なピンのリストです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_2.3_rgb.png]
PWMピンのpin27、pin26、pin25はそれぞれRGB LEDの赤、緑、青のピンを制御し、共通カソードピンをGNDに接続します。これにより、異なるPWM値をこれらのピンに重ねて特定の色をRGB LEDに表示させることができます。

配線図

[image: ../../_images/rgb_pin.jpg]
RGB LEDには4つのピンがあります：長いピンが共通のカソードピンで、通常はGNDに接続されています。最も長いピンの隣の左側のピンが赤で、右側の二つのピンが緑と青です。

[image: ../../_images/2.3_color_light_bb.png]
コード

ここでは、お好きな色を描画ソフト（たとえばペイント）で選び、RGB LEDで表示させます。


注釈


	esp32-starter-kit-main\c\codes\2.3_rgb_led のパスの下にあるファイル 2.3_rgb_led.ino を開けます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    2.4 マイクロチップ - 74HC595
    

    

    
 
  

    
      
          
            
  
2.4 マイクロチップ - 74HC595

このエキサイティングなプロジェクトへようこそ！このプロジェクトでは、74HC595チップを使用して8つのLEDの流れるような表示を制御します。

このプロジェクトを起動すると、8つのLED間で飛び交うかのような魅惑的な光の流れが目の前に広がります。一つ一つのLEDが順に点灯し、すぐに消えていく間に、次のLEDが輝き続け、美しくダイナミックな効果を生み出します。

74HC595チップを巧みに利用することで、複数のLEDのオン/オフ状態を制御し、流れるような効果を実現できます。このチップには複数の出力ピンがあり、LEDの点灯順序を制御するために直列に接続できます。さらに、チップの拡張性により、流れる表示にさらに多くのLEDを簡単に追加し、より壮観な効果を作り出すことができます。

必要な部品

このプロジェクトには以下のコンポーネントが必要です。

一式を購入するのが便利です。こちらがリンクです:








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






もちろん、以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	LED

	BUY



	74HC595

	BUY






利用可能なピン

このプロジェクトでESP32ボードに利用可能なピンのリストです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_2.4_74hc595_led.png]

	MR（ピン10）がハイレベルで、CE（ピン13）がローレベルのとき、SHcpの立ち上がりエッジでデータが入力され、SHcpの立ち上がりエッジを通してメモリレジスタに移動します。


	2つのクロックを接続すると、シフトレジスタはメモリレジスタよりも常に1パルス早くなります。


	メモリレジスタには、シリアルシフト入力ピン（DS）、シリアル出力ピン（Q7'）、非同期リセットボタン（ローレベル）があります。


	メモリレジスタは、3状態の並列8ビットバスを出力します。


	OEが有効（ローレベル）のとき、メモリレジスタのデータがバス（Q0 ～ Q7）に出力されます。




配線図

[image: ../../_images/2.4_74hc595_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\2.4_74hc595 のパスの下にある 2.4_74hc595.ino ファイルを開きます。


	ボード（ESP32 Dev Module）を選択し、適切なポートを選んだ後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    2.5 7セグメントディスプレイ
    

    

    
 
  

    
      
          
            
  
2.5 7セグメントディスプレイ

この魅力的なプロジェクトへようこそ！このプロジェクトでは、7セグメントディスプレイに0から9までの数字を表示する方法を探求します。

このプロジェクトを始動させると、0から9までの各数字が小さくコンパクトなディスプレイに鮮やかに光る様子を目にすることでしょう。まるで魅力的な方法で数字を紹介するミニチュアスクリーンを持っているかのようです。信号ピンを制御することで、表示される数字を簡単に変更し、さまざまな引き込まれるような効果を作り出すことができます。

シンプルな回路接続とプログラミングを通じて、7セグメントディスプレイとのやり取りの方法を学び、希望する数字を実際に表示させる方法を習得します。カウンターであれ、時計であれ、または他の面白い応用であれ、7セグメントディスプレイはあなたのプロジェクトに輝きを添える信頼できる仲間となるでしょう。

必要な部品

このプロジェクトには、以下のコンポーネントが必要です。

一式を購入するのが便利です。こちらがリンクです:








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






もちろん、以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	7セグメントディスプレイ

	BUY



	74HC595

	BUY






利用可能なピン

このプロジェクトでESP32ボードに利用可能なピンのリストです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_2.5_74hc595_7_segment.png]
ここでは、配線の原理は基本的に 2.4 マイクロチップ - 74HC595 と同じですが、唯一の違いは Q0-Q7 が7セグメントディスプレイの a 〜 g ピンに接続されている点です。


回路図





	74HC595

	LED Segment Display





	Q0

	a



	Q1

	b



	Q2

	c



	Q3

	d



	Q4

	e



	Q5

	f



	Q6

	g



	Q7

	dp






配線図

[image: ../../_images/2.5_segment_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\2.5_7segment のパスの下にある 2.5_7segment.ino ファイルを開きます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    2.6 文字の表示
    

    

    
 
  

    
      
          
            
  
2.6 文字の表示

ここでは、I2C LCD1602モジュールを使用した文字表示の魅力的な世界について探求します。

このプロジェクトを通じて、LCDモジュールの初期化、希望の表示パラメータの設定、画面に表示する文字データの送信方法を学びます。カスタムメッセージのショーケース、センサーの読み取りの表示、インタラクティブなメニューの作成などが可能です。可能性は無限大です！

I2C LCD1602で文字表示の技術を習得することにより、プロジェクトでの通信と情報表示の新たな道が開けます。このワクワクする旅に飛び込んで、LCDスクリーンにキャラクターを生き生きと表示しましょう。

必要な部品

このプロジェクトには、以下のコンポーネントが必要です。

一式を購入するのが便利ですが、こちらがリンクです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ジャンパーワイヤ

	BUY



	I2C LCD1602

	BUY






利用可能なピン

こちらは、このプロジェクトにおけるESP32ボードの利用可能なピンのリストです。







	利用可能なピン

	使用説明





	IO21

	SDA



	IO22

	SCL






回路図

[image: ../../_images/circuit_2.6_lcd.png]
配線図

[image: ../../_images/2.6_i2clcd1602_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\2.6_lcd1602 のパスの下にある 2.6_lcd1602.ino ファイルを開きます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？


	ここでは LiquidCrystal I2C ライブラリを使用しています。 Library Manager からインストールできます。


[image: ../../_images/lcd_lib.png]










  
    
    

    2.7 RGB LEDストリップ
    

    

    
 
  

    
      
          
            
  
2.7 RGB LEDストリップ

このプロジェクトでは、WS2812 LEDストリップの駆動と、鮮やかな色彩の展示を目指します。ストリップ上の各LEDを個別に制御する能力により、視覚を魅了するライティングエフェクトを作り出すことができます。

さらに、このプロジェクトにはランダム性の世界を探求するというワクワクする拡張機能を含んでいます。ランダムな色を導入し、流れるような光のエフェクトを実装することで、見る者を魅了する幻想的なビジュアル体験を創出します。

必要な部品

このプロジェクトには、以下のコンポーネントが必要です。

一式を購入するのが便利です。こちらがリンクです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ジャンパーワイヤ

	BUY



	WS2812 RGB 8 LED ストリップ

	BUY






回路図

[image: ../../_images/circuit_2.7_ws2812.png]
利用可能なピン

こちらはこのプロジェクトのためのESP32ボード上で利用可能なピンのリストです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23







注釈

IO33はこのプロジェクトでは使用できません。

WS2812 LEDストリップは、正確なパルス幅変調（PWM）信号を要求するタイプのLEDストリップです。PWM信号は時間と電圧の両方で厳密な要求があります。例えば、WS2812の「0」ビットは約0.4マイクロ秒のハイレベルパルスに対応し、「1」ビットは約0.8マイクロ秒のハイレベルパルスに対応します。これは、ストリップが高周波の電圧変化を受け取る必要があることを意味します。

しかし、IO33に4.7Kのプルアップ抵抗と100nfのプルダウンコンデンサーをつけると、簡単なローパスフィルターが作成されます。このタイプの回路は、コンデンサーが電圧変化を受けたときに充電と放電をする時間が必要なため、高周波信号を「平滑化」します。そのため、信号があまりにも速く変化する（つまり、高周波である）場合、コンデンサーは追い付けず、結果として出力信号がぼやけて、ストリップに認識不可能になります。



配線図

[image: ../../_images/2.7_rgb_strip_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\2.7_rgb_strip のパスの下にあるファイル 2.7_rgb_strip.ino を開くか、このコードを Arduino IDE にコピーしてください。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？


	ここでは Adafruit NeoPixel ライブラリが使用されています。これは Library Manager からインストールできます。


[image: ../../_images/rgb_strip_lib.png]










  
    
    

    3.1 ビープ音
    

    

    
 
  

    
      
          
            
  
3.1 ビープ音

このシンプルなプロジェクトでは、アクティブブザーを使って毎秒4回速くビープ音を鳴らします。

必要な部品

このプロジェクトには、以下のコンポーネントが必要です。

一式を購入することは非常に便利です。こちらがリンクです:








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






また、以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	ブザー

	-



	トランジスタ

	BUY






利用可能なピン

ここでは、このプロジェクトでESP32ボードに利用可能なピンのリストを示します。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_3.1_buzzer.png]
IO14の出力がハイのとき、1Kの電流制限抵抗を通って、S8050（NPNトランジスタ）が導通し、ブザーが鳴ります。

S8050（NPNトランジスタ）の役割は電流を増幅して、ブザーの音を大きくすることです。実際には、ブザーを直接IO14に接続することもできますが、ブザーの音が小さいことに気づくでしょう。

配線図

キットには2種類のブザーが含まれています。
アクティブブザーを使用する必要があります。それらをひっくり返すと、密封された背面（露出したPCBではない）が私たちが必要とするものです。

[image: ../../_images/buzzer.png]
ブザーの動作にはトランジスタが必要で、ここではS8050（NPNトランジスタ）を使用します。

[image: ../../_images/3.1_buzzer_bb.png]
コード


注釈


	ファイル 3.1_beep.ino をパス esp32-starter-kit-main\c\codes\3.1_beep から開いてください。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    3.2 カスタムトーン
    

    

    
 
  

    
      
          
            
  
3.2 カスタムトーン

前回のプロジェクトではアクティブブザーを使用しましたが、今回はパッシブブザーを使います。

アクティブブザーと同様に、パッシブブザーも電磁誘導の現象を利用して動作します。違いは、パッシブブザーには発振源がないため、直流信号を使ってもビープ音は鳴りません。
しかし、これによりパッシブブザーは自分の発振周波数を調整でき、「ド、レ、ミ、ファ、ソ、ラ、シ」といった異なる音符を出すことができます。

パッシブブザーにメロディを鳴らしてみましょう！

必要な部品

このプロジェクトでは、以下のコンポーネントが必要です。

一式を購入することは非常に便利です。こちらがリンクです:








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	ブザー

	-



	トランジスタ

	BUY






利用可能なピン

このプロジェクトのESP32ボードで利用可能なピンのリストはこちらです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_3.1_buzzer.png]
IO14の出力がハイの場合、1Kの電流制限抵抗を経てS8050（NPNトランジスタ）が導通し、ブザーが鳴ります。

S8050（NPNトランジスタ）の役割は電流を増幅し、ブザーの音を大きくすることです。実際には、ブザーを直接IO14に接続することもできますが、ブザーの音が小さいことがわかるでしょう。

配線図

キットには2種類のブザーが含まれています。私たちはパッシブブザーを使用する必要があります。それらを回して、露出したPCBが私たちが必要とするものです。

[image: ../../_images/buzzer.png]
ブザーの動作にはトランジスタが必要で、ここではS8050（NPNトランジスタ）を使用します。

[image: ../../_images/3.1_buzzer_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\3.2_custom_tone のパスの下にある 3.2_custom_tone.ino ファイルを開きます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    4.1 モーター
    

    

    
 
  

    
      
          
            
  
4.1 モーター

このプロジェクトでは、L293Dを使ってモーターを駆動する方法について探求します。

L293Dは、電子工作やロボットプロジェクトのモーター制御によく使用される汎用性の高い集積回路（IC）です。前進・後進の両方向に2つのモーターを駆動することができ、精密なモーター制御を要するアプリケーションで好まれて使用されます。

この魅力的なプロジェクトを終えるころには、デジタル信号とPWM信号を使ってモーターを効果的に制御する方法について、徹底的な理解を得ることができるでしょう。この貴重な知識は、ロボティクスやメカトロニクスの分野での将来の取り組みにおいて、確かな基盤となるはずです。準備を整えて、L293Dを使ったモーター制御のエキサイティングな世界に飛び込む準備をしましょう！

必要な部品

このプロジェクトには、以下の部品が必要です。

一式を購入するのが便利です。リンクはこちらです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






また、以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	DCモータ

	BUY



	L293D

	-






利用可能なピン

このプロジェクトでESP32ボードで利用可能なピンのリストです。







	利用可能なピン

	IO13, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_4.1_motor_l293d.png]
配線図


注釈

モーターは比較的高い電流が必要なので、最初にバッテリーを差し込み、拡張ボード上のスイッチをON位置にスライドしてバッテリー供給を有効にする必要があります。



[image: ../../_images/4.1_motor_l293d_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\4.1_motor のパス下にある 4.1_motor.ino ファイルを開きます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    4.2 水ポンプ制御
    

    

    
 
  

    
      
          
            
  
4.2 水ポンプ制御

この興味深いプロジェクトでは、L293Dを用いて水ポンプを制御する方法について探ります。

水ポンプ制御の領域では、他のモーター制御に比べて少しシンプルです。このプロジェクトの美点はその単純さにあります - 回転方向について心配する必要がありません。私たちの主目的は水ポンプを成功裏に活動させ、稼働させ続けることです。

必要な部品

このプロジェクトには、以下の部品が必要です。

一式を購入することは確かに便利です。リンクはこちらです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入も可能です。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	遠心ポンプ

	-



	L293D

	-






利用可能なピン

このプロジェクトでESP32ボードで利用可能なピンのリストです。







	利用可能なピン

	IO13, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_4.1_motor_l293d.png]
配線図


注釈

ここではバッテリーを差し込み、その後拡張ボード上のスイッチをON位置にスライドして、バッテリー供給を有効にすることを推奨します。



[image: ../../_images/4.2_pump_l293d_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\4.2_pump のパス下にある 4.2_pump.ino ファイルを開きます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    4.3 サーボモータのスイング
    

    

    
 
  

    
      
          
            
  
4.3 サーボモータのスイング

サーボモータは特定の角度を維持し、正確な回転を実現する位置制御デバイスとして知られています。これは、一貫した角度調整を要求する制御システムにとって非常に望ましい特性です。そのため、サーボは高品質な遠隔操作玩具、飛行機モデルから潜水艦のレプリカ、高度な遠隔操作ロボットに至るまで、幅広く使用されています。

この魅力的なプロジェクトでは、サーボモータを独自の方法で操作する挑戦をします - スイングさせるのです！このプロジェクトはサーボモータの動きをより深く理解し、精密な制御システムのスキルを磨く絶好の機会を提供します。

サーボモータをあなたのリズムに合わせて踊らせる準備はできましたか？さあ、このエキサイティングな冒険に出発しましょう！

必要な部品

このプロジェクトには、以下の部品が必要です。

全てをセットで購入するのが便利ですが、こちらがリンクです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ジャンパーワイヤ

	BUY



	サーボ

	BUY






利用可能なピン

このプロジェクトでESP32ボードで利用できるピンのリストです。







	利用可能なピン

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23






回路図

[image: ../../_images/circuit_4.3_servo.png]
配線図


	オレンジ色のワイヤーはシグナルで、IO25に接続します。


	赤いワイヤーはVCCで、5Vに接続します。


	茶色のワイヤーはGNDで、GNDに接続します。




[image: ../../_images/4.3_swinging_servo_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\4.3_servo のパスから 4.3_servo.ino ファイルを開くか、このコードを Arduino IDE にコピーしてください。


	ボード（ESP32 Dev Module）と適切なポートを選んだ後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？


	ここでは ESP32Servo ライブラリを使用します。 Library Manager からインストールできます。


[image: ../../_images/servo_lib.png]










  
    
    

    5.1 ボタン値の読み取り
    

    

    
 
  

    
      
          
            
  
5.1 ボタン値の読み取り

このインタラクティブなプロジェクトでは、ボタンの制御とLEDの操作について学びます。

そのコンセプトはシンプルでありながら効果的です。ボタンの状態を読み取り、ボタンが押されると高電圧レベル（'high state'）が登録され、これがLEDが点灯するトリガーとなります。

必要な部品

このプロジェクトには、以下のコンポーネントが必要です。

一式を購入すると便利です。こちらがリンクです：








	名前

	このキットのアイテム

	リンク





	ESP32 Starter Kit

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入することもできます。







	コンポーネントの紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	LED

	BUY



	ボタン

	BUY






利用可能なピン


	利用可能なピン


このプロジェクトのESP32ボード上で利用可能なピンのリストです。







	入力用

	IO14, IO25, I35, I34, I39, I36, IO18, IO19, IO21, IO22, IO23



	出力用

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23











	条件付き使用ピン（入力）


以下のピンには内蔵のプルアップまたはプルダウン抵抗があるため、 入力ピンとして使用する場合 外部抵抗は不要です：







	条件付き使用ピン

	説明





	IO13, IO15, IO2, IO4

	47K抵抗でプルアップし、デフォルト値を高にします。



	IO27, IO26, IO33

	4.7K抵抗でプルアップし、デフォルト値を高にします。



	IO32

	1K抵抗でプルダウンし、デフォルト値を低にします。











	ストラッピングピン（入力）


ストラッピングピンは、デバイスの起動時（電源オンリセット時）に特定のブートモードを決定するために使用される特別なピンのセットです。







	ストラッピングピン

	IO5, IO0, IO2, IO12, IO15






一般に、これらのピンを入力ピンとして使用することは お勧めしません。これらのピンを使用する場合は、ブートプロセスに与える潜在的な影響を考慮してください。詳細については、 ストラッピングピン セクションを参照してください。








回路図

[image: ../../_images/circuit_5.1_button.png]
ボタンの一方の端子を3.3Vに、もう一方の端子をIO14に接続してください。ボタンを押すとIO14がハイ状態になり、LEDが点灯します。ボタンを離すとIO14は浮遊状態に戻りますが、これはハイまたはローのいずれかになります。ボタンが押されていないときに安定したローレベルを確保するために、IO14は10Kのプルダウン抵抗を介してGNDに接続されるべきです。

配線図

[image: ../../_images/5.1_button_bb.png]

注釈

4ピンボタンはH型に設計されています。ボタンが押されていない状態では、左右のピンが接続されておらず、電流が流れません。しかし、ボタンを押すと左右のピンが接続され、電流が流れる経路が作られます。



コード


注釈


	esp32-starter-kit-main\c\codes\5.1_button のパスの下にあるファイル 5.1_button.ino を開くことができます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    5.2 傾けて操作！
    

    

    
 
  

    
      
          
            
  
5.2 傾けて操作！

傾斜スイッチはシンプルで効果的な2ピンデバイスで、その中心に金属球が含まれています。スイッチが垂直の位置にあるときは、2本のピンが電気的に接続されており、電流が流れます。しかし、スイッチが傾いたり特定の角度で傾けられたりすると、金属球が移動しピン間の電気的接続を断ちます。

このプロジェクトでは、傾斜スイッチを使用してLEDの照明を制御します。スイッチを傾動動作を引き起こすように配置することで、スイッチの向きに基づいてLEDをオン/オフ切り替えることができます。

必要なコンポーネント

このプロジェクトには、以下のコンポーネントが必要です。

全キットを購入すると非常に便利です。こちらがリンクです：








	名称

	このキットに含まれるアイテム

	リンク





	ESP32 スターターキット

	320+

	ESP32 Starter Kit






以下のリンクから個別に購入することもできます。







	コンポーネント紹介

	購入リンク





	ESP32 WROOM 32E

	BUY    



	ESP32カメラ拡張ボード

	-



	ブレッドボード

	BUY



	ジャンパーワイヤ

	BUY



	抵抗器

	BUY



	LED

	BUY



	傾斜スイッチ

	-






利用可能なピン


	利用可能なピン


このプロジェクトのためにESP32ボードで利用可能なピンのリストです。







	入力用

	IO14, IO25, I35, I34, I39, I36, IO18, IO19, IO21, IO22, IO23



	出力用

	IO13, IO12, IO14, IO27, IO26, IO25, IO33, IO32, IO15, IO2, IO0, IO4, IO5, IO18, IO19, IO21, IO22, IO23











	条件付き利用ピン（入力）


以下のピンには内蔵のプルアップまたはプルダウン抵抗があり、 入力ピンとして使用する場合 外部の抵抗は必要ありません。







	条件付き利用ピン

	説明





	IO13, IO15, IO2, IO4

	47Kの抵抗でプルアップして高い値がデフォルトになります。



	IO27, IO26, IO33

	4.7Kの抵抗でプルアップして高い値がデフォルトになります。



	IO32

	1Kの抵抗でプルダウンして低い値がデフォルトになります。











	ストラッピングピン（入力）


ストラッピングピンは、デバイス起動時（電源オンリセット時）に特定のブートモードを決定するために使用される特別なセットのピンです。







	ストラッピングピン

	IO5, IO0, IO2, IO12, IO15






一般的に、 入力ピンとして使用することは推奨されません。これらのピンを使用する場合は、ブートプロセスへの影響を考慮してください。詳細は、ストラッピングピン セクションを参照してください。








回路図

[image: ../../_images/circuit_5.2_tilt.png]
傾斜スイッチが垂直な位置にある場合、IO14が高く設定され、その結果LEDが点灯します。反対に、傾斜スイッチが傾いている場合、IO14は低く設定され、LEDが消えます。

10K抵抗の目的は、傾斜スイッチが傾いている位置にあるときにIO14が安定した低状態を維持することです。

配線図

[image: ../../_images/5.2_tilt_switch_bb.png]
コード


注釈


	esp32-starter-kit-main\c\codes\5.2_tilt_switch のパスの下にあるファイル 5.2_tilt_switch.ino を開くことができます。


	ボード（ESP32 Dev Module）と適切なポートを選択した後、 アップロード ボタンをクリックします。


	"Unknown COMxx"が常に表示されますか？







  
    
    

    5.3 障害物の検出
    

    

    
 
  

    
      
          
            
  
5.3 障害物の検出

このモジュールは一般的に車やロボットに設置され、前方の障害物の有無を判定するために使用されます。また、携帯型デバイスや自動